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BAB III 

METODOLOGI PENELITIAN 

 

A. Tempat dan Waktu Penelitian  

Tempat pelaksanaan penelitian ini yaitu di SMP N 6 Kota Solok pada 

kelas VIII, sedangkan waktu penelitian ini adalah semester I (Ganjil), 18 

Oktober 2017 s.d 18 Desember 2017. 

B. Jenis Penelitian  

Jenis penelitian yang digunakan adalah penelitian eksperimen. 

Penelitian eksperimen dapat diartikan sebagai metode penelitian yang 

digunakan untuk mencari pengaruh perlakuan tertentu terhadap yang lain 

dalam kondisi yang terkendalikan.1 Menurut Wiersma sebagaimana yang 

dikutip dalam buku karangan Emzir, menyatakan bahwa eksperimen sebagai 

suatu situasi penelitian yang sekurang-kurangnya satu variable bebas, yang 

disebut sebagai variabel eksperimental, sengaja dimanipulasi oleh peneliti.2 

 

C. Variabel Penelitian 

Penelitian ini menggunakan pola hubungan kausal dimana hubungan 

yang bersifat sebab akibat yang terdapat variabel independent atau variabel 

bebas (variabel yang mempengaruhi) dan variabel dependent atau variabel 

                                                 
1 Sugiyono, Metode  Penelitian  Pendidikan  Pendekatan  Kuantitatif Kualitatif dan R & D,   

(Bandung: Alfabeta, 2011),  h.107 
2  Emzir, Metodologi Penelitian Pendidikan Kuantitatif & Kualitatif (Jakarta: Rajawali Pers, 

2013), h. 63 
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terikat (dipengaruhi). Kata variabel berasal dari bahasa inggris “variabel” 

dengan arti “ubahan, faktor tak tetap, atau gejala yang dapat diubah-ubah”.3  

Dalam hal penelitian ini terdapat dua variabel yaitu variabel 

independent yang disebut sebagai variabel input, stimulus, prediktor, atau 

variabel bebas (X) yaitu penerapan strategi pembelajaran aktif teknik Critical 

Incident dan variabel dependent yang sering disebut sebagai variabel output, 

respon, atau variabel terikat (Y) hasil belajar peserta didik. Secara skematis 

dapat digambarkan sebagai berikut : 

 

 

 

 

1. Variabel independent (Penerapan strategi pembelajaran aktif teknik 

Critical Incident pada mata pelajaran Pendidikan Agama Islam). Variabel 

independent dalam penelitian ini adalah penerapan strategi pembelajaran 

aktif teknik Critical Incident dalam pembelajaran PAI kelas VII SMP  N 6 

Kota Solok. 

2. Variabel dependent (Hasil belajar peserta didik  pada mata pelajaran PAI). 

Variabel dependent dalam penelitian ini adalah hasil belajar peserta didik  

pada mata pelajaran PAI kelas VIII SMP N 6 Kota Solok.  

Penelitian ini mengkaji pengaruh penerapan strategi pembelajaran 

aktif teknik Critical Incident (X) sebagai variabel bebas (variabel 

                                                 
 3 Anas Sudijono, Pengantar Statistik Pendidikan, (Jakarta: PT.Raja Grafindo Persada, 2001), 

Cet. 11, h. 33   

 

Variabel bebas (X) 

penerapan strategi 

pembelajaran aktif teknik 

Critical Incident 

 

 

Variabel terikat (Y) 

Hasil belajar peserta 

didik 
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independent) dan hasil belajar peserta didik (Y) sebagai variabel terikat 

(variabel dependent).  

 

D. Desain Penelitian 

Secara definisi, desain penelitian mempunyai dua macam pengertian, 

yaitu secara luas dan sempit. Secara luas, desain penelitian adalah semua 

proses yang diperlukan dalam perencanaan dan pelaksanaan penelitian. Desain 

penelitian secara sempit dapat diartikan sebagai penggambaran secara jelas 

tentang hubungan antar variabel, pengumpulan data, dan analisis data, 

sehingga dengan adanya desain yang baik peneliti maupun orang lain yang 

berkepentingan mempunyai gambaran tentang bagaimana keterkaitan antara 

variabel yang ada dalam konteks penelitian dan apa yang hendak dilakukan 

oleh seorang peneliti dalam melaksanakan penelitian.4  

Desain penelitian yang digunakan dalam penelitian ini adalah 

“Posttest  Only  Control Group Design”. Posttest  Only  Control Group 

Design yaitu suatu penelitian yang menempatkan subjek penelitian ke dalam 

dua kelas yang dibedakan menjadi kategori kelas eksperimen dan kelas 

kontrol. Kelas eksperimen dengan menggunakan strategi pembelajaran aktif 

teknik Critical Incident sedangkan kelas kontrol dengan strategi pembelajaran 

langsung.5 Berikut ini merupakan tabel design penelitian Posttest Only 

Control Group Design. 

 

                                                 
4 Sukardi, Metodologi Penelitian Pendidikan : Kompetensi dan Praktiknya, (Jakarta: Bumi 

Aksara, 2003), h. 183 
5 Sugiyono, Op, Cit, h. 112. 
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Tabel 3.1 

Desain penelitian Posttest Only Control Group Design 

 

 

 

 

 

Keterangan: 

R1 : Random (Keadaan awal kelompok eksperimen)  

R2 : Random (Keadaan awal kelompok kontrol)  

X : Treatment (Perlakuan)  

O1: Pengaruh diberikannya treatment  

O2 : Pengaruh tidak diberikannya treatment  

Dalam desain ini terdapat dua kelompok yang masing-masing dipilih 

secara random (R). Kelompok pertama diberi perlakuan (X) dan kelompok 

yang lain tidak. Kelompok yang diberi perlakuan disebut kelompok 

eksperimen dan kelompok yang tidak diberi perlakuan disebut kelompok 

kontrol. Pengaruh adanya perlakuan (treatment) adalah (O1 : O2). Dalam 

penelitian yang sesungguhnya, pengaruh treatment dianalisis dengan uji beda, 

pakai statistik t-test misalnya. Kalau terdapat perbedaan yang signifikan 

antara kelompok eksperimen dan kelompok kontrol, maka perlakuan yang 

diberikan berpengaruh secara signifikan.6 

 

                                                 
 6 Ibid, h. 112   

 

R1  X O1 

 

R2  _ O2 
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E. Populasi dan Sampel 

1. Populasi 

Populasi adalah wilayah generalisasi yang terdiri atas: 

obyek/subyek yang mempunyai kualitas dan karakteristik tertentu yang 

ditetapkan oleh peneliti untuk dipelajari dan kemudian ditarik 

kesimpulannya.7 Dalam penelitian ini yang akan menjadi populasi adalah 

seluruh peserta didik kelas VIII SMP N 6 Kota Solok, yang dapat dilihat 

pada tabel berikut: 

 Tabel 3.2 

Gambaran Umum Populasi 

Jumlah Peserta Didik Kelas X IPA SMA Negeri 1 Gunung Talang 

No Kelas Jumlah Responden 

1 VIII 1 31 

2 VIII 2 30 

3 VIII 3 30 

4 VIII 4 28 

5 VIII 5 28 

6 VIII 6 29 

Jumlah 176 

Sumber: Tata Usaha SMP N 6 Kota Solok 

2. Sampel 

Sampel adalah bagian dari jumlah dan karakteristik yang dimiliki 

oleh populasi tersebut. Bila populasi besar, dan peneliti tidak mungkin 

mempelajari semua yang ada pada populasi, misalnya karena keterbatasan 

dana, tenaga dan waktu, maka peneliti dapat menggunakan sampel yang 

diambil dari populasi itu. Apa yang dipelajari dari sampel itu, 

                                                 
7  Sugiyono, Op, Cit, h. 117 
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kesimpulannya akan dapat diberlakukan untuk populasi. Untuk itu, sampel 

yang diambil dari populasi harus betul-betul representative (mewakili).8 

Berdasarkan populasi yang telah penulis paparkan diatas, maka 

teknik pengambilan sampel yang digunakan yaitu simple random sampling  

dimana pengambilan anggota sampel dari populasi dilakukan secara acak 

tanpa memperhatikan strata yang ada dalam populasi itu yaitu dengan cara 

undian kelas.9 

Pengambilan secara undian ialah seperti layaknya melaksanakan 

undian. Adapun langkah-langkahnya adalah sebagai berikut: 

a. Membuat daftar yang berisi semua objek, subjek, peristiwa atau 

kelompok-kelompok yang diselidiki yaitu terdiri dari 6 kelas VIII. 

b. Memberi kode berupa angka-angka untuk semua yang akan diselidiki 

dalam nomor 1-6. 

c. Menulis kode tersebut pada masing-masing selembar kertas kecil. 

d. Menggulung setiap kertas kecil berkode tersebut. 

e. Memasukkan gulungan-gulungan dalam kaleng atau tempat sejenis. 

f. Mengocok kaleng tersebut. 

g. Mengambil satu persatu gulungan tersebut sejumlah kebutuhan.10 

Adapun sampel yang penulis ambil dari populasi kelas VIII SMP N 

6 Kota Solok diatas yang telah dilakukan secara undian yaitu kelas VIII 2 

sebagai kelas eksperimen dan kelas VIII 3 sebagai kelas kontrol.  

                                                 
8  Sugiyono, Op, Cit, h. 118 
9 Cholid Narbuko, Abu Ahmadi, Metodologi Penelitian, ( Jakarta: Bumi Aksara, 2009), h. 

110  
10 Amirul Hadi, Haryono, Metodologi Penelitian Pendidikan, (Bandung: Pustaka Setia, 

1998), h. 199 
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F. Data dan Sumber Data 

1. Data 

Data adalah hasil pencatatan peneliti, baik berupa fakta ataupun 

angka.11 Adapun jenis data dalam penelitian ini yaitu data primer dimana 

data yang diperoleh atau bersumber dari tangan pertama. Dalam hal ini 

data primernya adalah data hasil ulangan mata pelajaran Pendidikan 

Agama Islam peserta didik kelas VIII SMP N 6 Kota Solok. 

2. Sumber Data 

Sehubungan dengan jenis data yang diperlukan maka sumber data 

yang diperlukan adalah Seluruh peserta didik kelas VIII 2 dan VIII 3 SMP 

N 6 Kota Solok yang menjadi kelas sampel untuk mendapatkan data 

primer. 

 

G. Prosedur Penelitian 

Penelitian  ini  dilaksanakan  di  SMP N 6 Kota Solok kelas VIII. 

Adapun kelas yang digunakan  untuk  penelitian  adalah  kelas VIII 2  sebagai  

kelas eksperimen  dengan 30 orang peserta didik  dan VIII 3 sebagai  kelas 

kontrol  dengan 30 orang peserta didik. Sebelum  diberi  perlakuan  dengan  

model  yang  berbeda, terlebih dahulu dipastikan bahwa kelas eksperimen dan 

kelas kontrol tersebut memiliki kemampuan yang seimbang. Oleh karena  itu 

dilakukan uji normalitas dan uji homogenitas yang diambil  dari nilai ulangan 

harian semester ganjil tahun pelajaran 2017/ 2018. 

Prosedur penelitian dilakukan dengan tiga tahapan sebagai berikut: 

                                                 
11 Suharsimi Arikunto, Op, Cit, h. 161. 
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1. Tahap Persiapan 

Pada Tahap ini dipersiapkan sesuatu yang dipergunakan dalam penelitian 

yaitu : 

a. Menetapkan tempat penelitian. 

b. Menentukan jadwal penelitian. 

c. Mempersiapkan kelas eksperimen dan kontrol. 

d. Mempersiapkan rencana pelaksanaan pembelajaran (RPP) sebagai 

pedoman dalam proses pembelajaran. 

e. Mempersiapkan kisi-kisi soal tes uji coba hasil belajar yang akan 

diberikan pada peserta didik di akhir pembelajaran. 

f. Mempersiapkan soal tes hasil belajar yang akan diberikan kepada 

peserta didik pada akhir pembelajaran. 

2. Tahap Pelaksanaan 

Pada tahap pelaksanaan pembelajaran yang dilakukan pada kedua 

kelas yaitu kelas eksperimen dan kelas kontrol dengan langkah-langkah 

sebagai berikut: 

Tabel 3.2 

Perbandingan Perlakuan Pada Kelas Eksperimen Dan Kelas Kontrol 

Kelas Eksperimen Kelas Kontrol 

Kegiatan Pendahuluan 

1. Guru masuk kelas dengan 

mengucapkan salam. 

2. Guru menyiapkan kelas sebelum 

memulai pelajaran. 

3. Guru meminta peserta didk untuk 

berdo’a. 

4. Guru mencek kehadiran peserta 

didik. 

Kegiatan Pendahuluan 

1. Guru masuk kelas dengan 

mengucapkan salam. 

2. Guru menyiapkan kelas sebelum 

memulai pelajaran. 

3. Guru meminta peserta didk untuk 

berdo’a. 

4. Guru mencek kehadiran peserta 

didik. 
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5. Guru menyiapkan pembelajaran 

dengan memberitahu topik yang 

akan dipelajari. 

6. Guru menyampaikan tujuan 

pembelajaran. 

5. Guru menyiapkan pembelajaran 

dengan memberitahu topik yang 

akan dipelajari. 

6. Guru menyampaikan tujuan 

pembelajaran 

 

 

Kegiatan Inti 

1. Mengamati 

a. Guru memberikan kesempatan 

kepada peserta didik untuk 

mengingat-ingat pengalaman 

yang dialami dan tidak 

terlupakan berkaitan dengan 

materi yang disampaikan. 

2. Menanya  

a. Guru membimbing peserta 

didik bertanya tentang 

pengalaman-pengalaman yang 

dialami tersebut terkait dengan 

materi yang dipelajari. 

3. Mencoba  

a. Guru membimbing peserta 

didik untuk menyampaikan 

beberapa pengalaman yang 

dialami oleh peserta didik 

tersebut dan tidak terlupakan 

berkaitan dengan materi yang 

disampaikan.  

4. Menalar  
a. Guru membimbing peserta 

didik untuk mengidentifikasi 

pengalaman-pengalaman yang 

dialami tersebut disesuaikan 

dengan pokok bahasan yang 

akan dikaji pada saat 

pembelajaran untuk kajian 

kelas. 

5. Mengkomunikasikan  
1. Guru membimbing peserta didik 

yang lain untuk menanggapi, 

menyanggah dan mengajukan 

pertanyaan terhadap pengalaman 

yang disampaikan oleh temannya. 

 

Kegiatan Inti 

1. Mengamati  

a. Guru menuliskan dan 

menjelaskan materi yang akan 

dipelajari di papan tulis. 

2. Menanya 

a. Guru membimbing peserta 

didik mengajukan pertanyaan 

berdasarkan apa yang telah di 

amatinya. 

3. Mencoba 

a. Guru membimbing peserta 

didik mencoba membacakan 

materi yang sedang dipelajari. 

4. Menalar 

a. Guru membimbing peserta 

didik dalam memahami konsep 

materi yang dipelajari. 

b. Guru membimbing peserta 

didik untuk menyimpulkan 

materi yang telah dipelajari. 

5. Mengkomunikasikan  

1. Guru 

membimbing 

peserta didik 

untuk 

mempraktekkan 

materi dalam 

kehidupan. 

Kegiatan Penutup  Kegiatan Penutup 
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2. Guru bersama peserta didik 

menyimpulkan materi yang sudah 

dipelajari. 

3. Guru memberitahu materi 

selanjutnya. 

4. Guru bersama siswa menutup 

pembelajaran dengan 

mengucapkan hamdallah. 

5. Kemudian meminta siswa 

mengucapkan salam secara 

bersama, dan guru menjawab 

salam dari siswa. 

 

1. Guru bersama peserta didik 

menyimpulkan materi yang sudah 

dipelajari. 

2. Guru memberitahu materi 

selanjutnya. 

3. Guru bersama siswa menutup 

pembelajaran dengan 

mengucapkan hamdallah. 

4. Kemudian meminta siswa 

mengucapkan salam secara 

bersama, dan guru menjawab 

salam dari siswa. 

 

3. Tahap Evaluasi Pembelajaran 

Evaluasi  merupakan  pelaksanaan  tes  untuk mengukur 

kemampuan  peserta didik  pada  kelas  eksperimen dan  kelas  kontrol 

setelah  mendapat  pembelajaran dengan menerapkan  model  

pembelajaran  yang  berbeda. Penerapan  tes  tertulis  atau  evaluasi  ini  

bertujuan untuk  mendapatkan  data  tentang  hasil  belajar  peserta didik 

setelah  mendapat  perlakuan.  Data  yang  didapatkan dari  evaluasi  

dengan  cara  menggunakan posttest  yang merupakan  data akhir   sebagai  

pembuktian hipotesis penulis.   

 

H. Instrumen Penelitian 

Untuk memperoleh data tentang hasil belajar peserta didik, penulis 

menggunakan alat pengumpulan data yang berbentuk tes hasil belajar. Tes 

hasil belajar berfungsi untuk mengukur tingkat kemampuan individu, baik 

dalam bidang pengetahuan maupun keterampilan sebagai hasil belajar. Tes 

tersebut berfungsi untuk mengetahui hasil belajar peserta didik pada mata 
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pelajaran Pendidikan Agama Islam setelah menggunakan model pembelajaran 

berbasis portofolio. Dalam penelitian ini di gunakan tes tertulis yang 

berbentuk pilihan ganda. 

Tes hasil belajar dimaksud adalah tes yang diberikan setelah penelitian 

dilaksanakan. Adapun langkah-langkah yang dilakukan sebagai berikut: 

1. Menyusun Tes 

Dalam menyusun tes tersebut penulis melakukan tahapan sebagai berikut : 

a. Menentukan tujuan mengadakan tes, yaitu untuk mengetahui hasil 

belajar mata pelajaran Pendidikan Agama Islam peserta didik. 

b. Membuat pembatasan pada materi yang akan diujikan. 

c. Menyusun kisi-kisi tes hasil belajar mata pelajaran Pendidikan 

Agama Islam. 

d. Menyusun butir-butir soal tes uji coba. 

2. Melaksanakan Uji Coba Tes 

Hasil dari suatu penelitian adalah dapat dipercaya apabila data 

yang digunakan betul-betul akurat atau sudah memiliki reliabilitas, dan 

validitas soal. Agar soal yang disusun itu memiliki kriteria soal yang baik, 

maka soal tersebut perlu diuji coba terlebih dahulu di sekolah lain atau 

lokal lain. Kemudian dianalisis untuk mendapatkan soal mana yang 

memenuhi kriteria yang baik. 
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3. Melakukan Analisis Tes Uji Coba  

Setelah instrumen disusun sesuai dengan kisi-kisi soal yang dibuat, 

kemudian instrumen tersebut divalidasi oleh dua orang validator yaitu 

dosen  pembimbing I dan dosen pembimbing II. Selanjutnya dilakukan uji 

coba tes terlebih dahulu sebelum diberikan. Dengan uji coba tes ini 

diharapkan dapat diketahui soal-soal yang baik yang dapat dijadikan 

sebagai soal tes pada kelas sampel penelitian ini.  

Cara  yang  digunakan  untuk  mengetahui  baik  dan tidaknya  

instrumen  soal  tes  maka  perlu  diuji  coba  dan dianalisis.  Analisis  uji  

instrumen  soal  meliputi  analisis validitas,  reliabilitas,  indeks tingkat  

kesukaran dan indeks daya pembeda soal. Penjelasannya sebagai berikut: 

a. Validitas soal 

Validitas adalah ukuran yang menunjukkan  tingkat kevalidan  

atau  kesahihan  suatu  instrumen. Sebuah instrumen  dikatakan  valid  

apabila  instrumen  tersebut mempunyai  validitas  yang  tinggi.  

Sebaliknya,  instrumen yang kurang valid berarti memiliki validitas 

rendah. Ada empat jenis validias, yaitu validitas isi (contens validity), 

validitas konstruk (construct validity), validitas prediktif (predictive 

validity), dan validitas konkuren (concurent validity). Dalam 

penyusunan instrumen, peniliti berpedoman pada validitas isi. Apabila 

tes yang disusun sudah berdasarkan kisi-kisi yang telah dibuat, maka 

tes telah memenuhi validitas isi. 
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b. Reliabilitas  

Reliabilitas merupakan ketepatan suatu tes apabila digunakan 

kepada subjek yang sama. Untuk menentukan reliabilitas tes digunakan 

rumus Kuder Richarson (K-R 21) yaitu: 
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Keterangan: 

r11 : reliabilitas tes secara keseluruhan 

n : jumlah butir soal tes 

M : rata-rata skor tes 

N : jumlah pengikut tes 

S2 : variabel total 

x : skor pengikut tes12 

Untuk menentukan tingkat reliabilitas soal dapat digunakan skala yang 

dikemukakan pada tabel berikut: 

Tabel 3.4 

Reliability Statistic 

 

0,00 < r11 ≤ 0,20  = Sangat rendah  

0,20 < r11≤ 0,40   = Rendah  

0,40 < r11 ≤ 0,60  = Sedang  

0,60 < r11 ≤ 0,80  = Tinggi  

0,80 < r11 ≤ 1       = Sangat tinggi. 

 

Berdasarkan tabel di atas, maka soal yang baik adalah soal 

yang reliabilitasnya ≥ 0,40.13 

                                                 
12 Suharsimi Arikunto, Dasar-Dasar Evaluasi Pendidikan, ( Jakarta : Bumi Aksara, 

2002), h. 117 
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c. Indeks tingkat kesukaran  

Butir item tes hasil belajar dapat dinyatakan sebagai butir-butir  

item yang  baik,  apabila  butir-butir  item  tersebut  tidak  terlalu sukar  

dan  tidak  terlalu  mudah  dengan  kata  lain  derajat kesukaran  itu  

adalah  sedang  atau  cukup. Bilangan yang menunjukkan sukar atau  

mudahnya suatu soal disebut indeks kesukaran (P). untuk 

menentukan indeks kesukaran soal sebagai berikut: 

sJ

B
P 

 
 

Keterangan: 

 P :  Tingkat kesukaran 

B  :  Jumlah siswa yang menjawab soal dengan benar 

Js  :  Jumlah seluruh siswa peserta tes 

 

Tabel 3.5 

Indeks Tingkat Kesukaran Soal 

 

Tingkat Kesukaran Kategori Soal 

0,00 – 0,30 Sukar 

0,31 – 0,70 Sedang 

0,71 – 1,00 Mudah 

 

Berdasarkan tabel di atas, maka soal yang baik adalah soal 

yang tingkat kesukarannya 0,31 sampai dengan 0,70.14 

                                                                                                                                      
13  Ibid, hal. 220 
14 Kunandar, Penilaian Autentik (Penilaian Hasil Belajar Peserta Didik Berdasarkan 

Kurikulum 2013), ( Jakarta: Rajawali Pers, 2014), hal. 240 
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No 

Item 

 (D) Kriteria  (P) Kriteria Kesimpulan No 

Soal 

Akhir 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

15 

16 

17 

18 

19 

20 

21 

22 

23 

24 

25 

26 

27 

28 

0,34 

0,42 

0,50 

0,42 

0,25 

0,25 

0,42 

0,41 

0,50 

0,59 

0,42 

0,42 

0,25 

0,58 

0,42 

0,42 

0,41 

0,50 

0,34 

0,41 

0,17 

0,41 

0,17 

0,50 

0,41 

0,42 

0,41 

0,42 

Cukup   

Baik 

Baik  

Baik 

Cukup   

Cukup  

Baik 

Baik 

Baik 

Baik 

Baik 

Baik  

Cukup   

Baik 

Baik 

Baik 

Baik 

Baik 

Cukup  

Baik 

Lemah  

Baik 

Lemah  

Baik 

Baik 

Baik 

Baik 

Baik 

0,83 

0,54 

0,58 

0,62 

0,79 

0,54 

0,79 

0,70 

0,67 

0,70 

0,54 

0,62 

0,87 

0,62 

0,62 

0,62 

0,70 

0,67 

0,58 

0,70 

0,67 

0,70 

0,75 

0,50 

0,70 

0,62 

0,70 

0,62 

Mudah 

Sedang 

Sedang  

Sedang  

Mudah 

Sedang 

Mudah  

Sedang 

Sedang 

Sedang 
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Berdasarkan data di atas indeks tingkat kesukaran soal adalah, 

soal dalam kategori sukar : tidak ada, soal dalam kategori sedang 

terdapat pada soal nomor : 2, 3, 4, 6, 8, 9, 10, 11, 12, 14, 15, 16, 17, 18, 

19, 20, 21, 22, 24, 25, 26, 27, 28, 29, 30, 31, 33, 34, 35, 36, 37, 39. 

Soal dalam kategori mudah terdapat pada soal nomor : 1, 5, 7, 13, 23, 

32, 38, 40. 

d. Indeks daya pembeda soal 

 

Daya pembeda soal adalah kemampuan suatu soal untuk 

membedakan antara siswa yang pandai (berkemampuan tinggi) dengan 

29 
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siswa yang kurang pandai (berkemampuan rendah). Cara menentukan 

daya beda dapat menggunakan persamaan sebagai berikut: 15 

b

b

a

a

J

B

J

B
D   

Keterangan: 

D : Daya pembeda 

Ba : Jumlah kelompok atas yang menjawab benar 

Bb : Jumlah kelompok bawah yang menjawab benar 

Ja : Jumlah peserta kelompok atas 

Jb : Jumlah peserta kelompok bawah 

 

Indeks daya pembeda soal dapat diklasifikasikan seperti pada 

tabel berikut: 

Tabel 3.6 

Klasifikasi Indeks Daya Beda Soal 

 

Daya Pembeda Kategori Soal 

0,00 – 0,19 Lemah 

0,20 – 0,39 Cukup 

0,40 – 0,69 Baik 

0,70 – 1,00 Baik sekali 

Hasil negative Tidak baik 

                 
Berdasarkan tabel di atas, maka soal yang baik adalah soal 

yang memiliki indeks daya pembeda 0.40 sampai 0.70. dari data yang 

didapatkan klasifikasi indeks daya beda soal adalah, soal dalam 

kategori cukup terdapat pada nomor : 1, 5, 6, 13, 19. Soal dalam 

kategori baik terdapat pada nomor : 2,  3, 4, 7, 8, 9, 10, 11, 12, 14, 15, 

16, 17, 18, 20, 22, 24, 25, 26, 27, 28, 29, 30, 34, 35, 36, 37, 38, 39, 40. 

Soal dalam kategori lemah terdapat pada nomor : 21, 23, 31, 32, 33. 

 

                                                 
15  Ibid, hal. 228 
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I. Teknik Pengumpulan Data  

Pengumpulan data dapat dilakukan dalam berbagai setting, berbagai  

sumber, dan berbagai cara. Bila dilihat dari setting-nya, data dapat  

dikumpulkan  pada  pengaturan alamiah/natural setting, pada laboratorium 

dengan metode eksperimen, di rumah dengan berbagai responden, pada  suatu 

seminar, diskusi, di jalan dan lain-lain.16 

Jadi  pengumpulan  data  bertujuan  untuk  memperoleh fakta 

diperlukan untuk mencapai tujuan penelitian. Adapun teknik pengumpulan 

data yang digunakan  dalam  penelitian  ini  antara lain: 

1. Tes 

Tes merupakan alat atau prosedur yang digunakan untuk 

mengetahui  atau mengukur sesuatu dalam suasana, dengan cara dan 

aturan-aturan  yang sudah ditentukan17. Metode  ini  digunakan  untuk  

memperoleh  data hasil belajar peserta didik kelas eksperimen dan kelas 

kontrol pada  materi Ibadah Puasa Meningkatkan Pribadi yang Bertakwa. 

Metode tes yang digunakan dalam penelitian  ini adalah  metode tes 

pilihan ganda. Soal test pilihan ganda dapat  digunakan untuk mengukur 

hasil belajar yang kompleks yang berkenaan dengan aspek ingatan, 

pengertian, aplikasi, analisis, sintesis, dan evaluasi18. 

 

J. Teknik Analisis  data 

                                                 
16 Sugiyono, Op, Cit, h. 193 
17  Suharsimi Arikunto, Op, Cit, h. 53 
18  Zaenal Arifin, Evaluasi  Pembelajaran,  (Bandung:  Remaja Rosdakarya, 2011), h. 138 



63 

 

 

 

Analisis data merupakan kegiatan setelah data dari seluruh responden  

atau  sumber  data  lain  terkumpul,  kegiatan  ini  dalam analisis  data  adalah 

mengelompokkan  data  berdasarkan  variabel dan  jenis  responden, 

mentabulasi  data  berdasarkan  variabel  dari seluruh  responden,  menyajikan  

data  tiap  variabel  yang  diteliti, melakukan  perhitungan  untuk  menjawab  

rumusan  masalah,  dan melakukan  perhitungan  untuk  menguji  hipotesis  

yang  telah diajukan.19 Analisis  ini  dilakukan  untuk  menguji  hipotesa  dari 

penelitian  yang  telah  dirumuskan  sebelumnya,  yaitu  untuk mengetahui  

apakah  ada  pengaruh  penerapan  strategi pembelajaran aktif teknik critical 

incident terhadap hasil belajar peserta didik pada mata pelajaran Pendidikan 

Agama Islam. 

1) Uji Normalitas   

Uji  normalitas  data  dilakukan  untuk  mengetahui apakah data 

yang diperoleh didistribusikan normal atau tidak. Pengujian  normalitas  

data  dengan  menggunakan  uji-t  adalah sebagai berikut: 

 

1: skor rata-rata dari kelompok eksperimen  

2: skor rata-rata dari kelompok kontrol  

n1 : banyaknya subyek kelompok eksperimen  

n2 : banyaknya subyek kelompok kontrol  

s1²: varians kelompok eksperimen  

                                                 
19  Sugiyono, Op, Cit, h. 207 
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s2²: varians kelompok kontrol  

s²: varians gabungan 

Dengan kriteria pengujian  terima Ho apabila  ttabel <  thitung < ttabel , 

ttabel = t1 -  distribusi t dengan derajat  kebebasan  dk =  n1 +   n2-  2,  

taraf  signifikan 5%  dan tolak H0  untuk harga t  lainnya. Pengujian  

normalitas  data  dengan menggunakan program SPSS versi 21 dengan 

langkah-langkah: Memasukan data hasil belajar kelas eksperimen dan 

kelas kontrol > Klik Analyze > Descriptive Statistics > Explore > 

Dependent List > Plots > Klik Faktor Levels Together > Klik Histogram > 

Klik Normality Plots With Test > Klik Continue.20 

2) Uji Homogenitas   

Uji ini digunakan untuk mengetahui apakah kelompok eksperimen  

dan kelompok kontrol yang  ditetapkan  berasal dari populasi yang 

memiliki varian yang relatif sama. Rumus yang digunakan adalah: 

2

2

2

1S

S
F   

Keterangan: 

S1
2 = variansi hasil belajar kelas eksperimen 

S2
2 = variansi hasil belajar kelas kontrol 

Hipotesis yang diajukan: 

:0H  sampel mempunyai varians yang sama  

Ha :  sampel mempunyai varians yang tidak sama 

                                                 
20 Getut Pramesti, Smart Olah Data Penelitian dengan SPSS 21, (Jakarta: Elex Media 

Komputindo, 2013), h. 15 
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Kriteria pengujian: 

Apabila Fhitung < Ftabel  maka  data  berdistribusi homogen Ha 

ditolak. H0 diterima berarti varians homogen.21 Pengujian homogenitas 

data menggunakan program SPSS versi 21 dengan langkah-langkah 

berikut: Memasukan data hasil belajar kelas eksperimen dan kelas kontrol 

>  Klik Analyze > Klik Compare Means > Klik One Way ANOVA > 

Dependent List > Klik Options > Klik Descriptive > Klik Homogenety of 

variance test > Klik Means Plot > Klik Continue. 

3) Uji perbedaan dua rata-rata 

Setelah  sampel diberi perlakuan yang berbeda, maka dilaksanakan 

tes akhir. Teknik statistik yang digunakan adalah teknik  t-test  untuk 

menguji  signifikansi  perbedaan  dua  buah mean  yang  berasal  dari  dua  

buah  distribusi.  Pada  penelitian ini,  data  yang  digunakan  pada  

perhitungan  ini  adalah  data posttest.  Dari  hasil  tes  akhir  ini  akan  

diperoleh  data  yang digunakan  sebagai  dasar  dalam menguji  hipotesis  

penelitian, yaitu hipotesis diterima atau ditolak. Pengujian hipotesis yang 

digunakan adalah sebagai berikut :  

Ha : µ1 >  µ2  

H0 : µ1 ≤  µ2  

Keterangan :  

µ1 =  rata-rata hasil belajar peserta didik kelas eksperimen  

µ2 =  rata-rata hasil belajar peserta didik kelas kontrol  

                                                 
21 Sudjana, Metode Statistika, (Bandung: Tarsito, 2005), h. 250 


